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In This Guide…
To be able to use your new Agilent 8453 UV-visible spectroscopy system 
quickly, this book gives you step-wise procedures and examples for basic 
operations and tasks.

This book shall not replace the detailed manuals available for installation: 
Installing Your UV-visible Spectroscopy System and operation of your 
software Understanding Your UV-visible Spectroscopy System nor your 
Agilent 8453 Service Manual.

1 Introduction to Your System

In this chapter you will find an introduction to your Agilent 8453 
spectrophotmeter and the concept of your Agilent ChemStation software.

2 Installation and Start Up

In this chapter you will find a summary of system installation and start-up of 
a measurement session.

3 Good Measurement Practices

Good measurement practices are discussed in this chapter.

4 Using your Agilent 8453 UV-visible Spectroscopy System

Stepwise examples for basic measurements and related tasks are given in this 
chapter.
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Operation of the system is much easier if you understand the implementation 
models. The mind-models of data acquisition, data evaluation and data 
handling will help you to run the system successfully.

Your spectroscopy system is based on an Agilent 8453 spectrophotometer and 
general purpose Agilent ChemStation software for UV-visible spectroscopy 
running on a PC with the supported Microsoft operating system(s). These two 
components are linked together by a network connection. This type of link is 
very flexible: it can be used for a direct connection between the 
spectrophotometer and the PC as well as the integration in a enterprise 
network with network access from the PC to the spectrophotometer.

The tasks are split between these devices such that the spectrophotometer 
acquires and provides absorbance data which are handled by the PC’s 
application software. All of the data display, evaluation and longterm storage 
is done under software control on the PC.
9Agilent Technologies
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Agilent 8453 Spectrophotometer — Overview

This section gives an overview of the optical system and explains the 
spectrophotometer front and back panels. It also explains the layout and 
construction of the spectrophotometer including the electronic and 
mechanical assemblies inside the spectrophotometer.

Optical System Overview

Optical System

The optical system of the spectrophotometer is shown in Figure 1. Its 
radiation source is a combination of a deuterium-discharge lamp for the 
ultraviolet (UV) wavelength range and a tungsten lamp for the visible and 
short wave near-infrared (SWNIR) wavelength range. The image of the 
filament of the tungsten lamp is focused on the discharge aperture of the 
deuterium lamp by means of a special rear-access lamp design which allows 
both light sources to be optically combined and share a common axis to the 
source lens. The source lens forms a single, collimated beam of light. The beam 
passes through the shutter/stray-light correction filter area then through the 
sample to the spectrograph lens and slit. In the spectrograph light is dispersed 
onto the diode array by a holographic grating. This allows simultaneous access 
to all wavelength information. The result is a fundamental increase in the rate 
at which spectra can be acquired.
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• Lamps

The light source for the UV wavelength range is a deuterium lamp with a 
shine-through aperture. As a result of plasma discharge in a low pressure 
deuterium gas, the lamp emits light over the 190 nm to approximately 
800 nm wavelength range. The light source for the visible and SWNIR 
wavelength range is a low-noise tungsten lamp. This lamp emits light over 
the 370 nm to 1100 nm wavelength range.

• Source Lens

The source lens receives the light from both lamps and collimates it. The 
collimated beam passes through the sample (if one is present) in the sample 
compartment.

• Shutter

The shutter is electromechanically actuated. It opens and allows light to 
pass through the sample for measurements. Between sample measurements 
it closes to limit exposure of sample to light. If the measurement rate is very 
fast, you can command the shutter to remain open (Agilent ChemStation 
software) or it stays open automatically (handheld controller software).

Figure 1 Optical System of Spectrophotometer
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• Stray-Light Correction Filter

In a standard measurement sequence, reference or sample intensity spectra 
are measured without and then with the stray-light filter in the light beam. 
Without the filter the intensity spectrum over the whole wavelength range 
from 190–1100 nm is measured. The stray-light filter is a blocking filter 
with 50 % blocking at 420 nm. 

With this filter in place any light measured below 400 nm is stray light only. 
This stray-light intensity is then subtracted from the first spectrum to give a 
stray-light corrected spectrum. Depending on the software, you can switch 
off the stray light correction (Agilent ChemStation software) in case you 
want to do very fast repetitive scans or it is switched off automatically.

• Sample Compartment

The spectrophotometer has an open sample compartment for easier access 
to sample cells. Because of the optical design a cover for the sample area is 
not required. The spectrophotometer is supplied with a single-cell holder 
already installed in the sample compartment. This can be replaced with the 
Peltier temperature control accessory, the thermostattable cell holder, the 
long path cell holder or the multicell transport. All of these optional cell 
holders mount in the sample compartment using the same quick, simple 
mounting system. An optical filter wheel is also available for use with the 
spectrophotometer and most of the accessories.

• Spectrograph

The spectrograph housing material is ceramic to reduce thermal effects to a 
minimum. It main components of the spectrograph are the lens, the slit, the 
grating and the photo diode array with front-end electronics. The mean 
sampling interval of the diode array is about 0.9 nm over the wavelength 
range 190 nm to 1100 nm. The nominal spectral slit width is 1 nm.

• Spectrograph Lens

The spectrograph lens is the first of the parts which are collectively known 
as the spectrograph. It is mounted on the housing of the spectrograph. The 
spectrograph lens refocuses the collimated light beam after it has passed 
through the sample.
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• Slit

The slit is a narrow aperture in a plate located at the focus of the 
spectrograph lens. It is exactly the size of one of the photo diodes in the 
photo diode array. By limiting the size of the incoming light beam, the slit 
makes sure that each band of wavelengths is projected onto only the 
appropriate photodiode.

• Grating

The combination of dispersion and spectral imaging is accomplished by 
using a concave holographic grating. The grating disperses the light onto 
the diode array at an angle linear proportional to the wavelength.

• Diode Array

The photodiode array is the heart of the spectrograph. It is a series of 1024 
individual photodiodes and control circuits etched onto a semiconductor 
chip. With a wavelength range from 190 nm to 1100 nm the sampling 
interval is about 0.9 nm.
Agilent 8453 UV-visible Spectroscopy System Operator’s Manual 13
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Spectrophotometer Description

Your spectrophotometer is very easy to use. It has a line power indicator, a 
status indicator and some push buttons. All electrical connections are made at 
the rear of the spectrophotometer.

Front View

The front view of the spectrophotometer is shown in Figure 2. Notice that the 
sample compartment is open. Unlike conventional spectrophotometers the 
Agilent 8453 does not suffer from ambient false light. The open sample area 
makes it easier to access for cuvette handling and to connect tubing to a flow 
cell or thermostattable cell holder. The spectrophotometer is shipped with the 
standard single-cell holder. Standard and accessory cell holders can be 
removed and replaced in seconds with few or no tools.

The line power switch is located at the lower-left part of the 
spectrophotometer. Pressing it in turns on the spectrophotometer. It stays 
pressed in and shows a green light when the spectrophotometer is turned on. 
When the line power switch stands out and the green light is off, the 
spectrophotometer is turned off.

Figure 2 Front View of Spectrophotometer
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On the front panel of the spectrophotometer is a status indicator which will 
display different colors depending of the actual condition of the 
spectrophotometer.

• Green—the spectrophotometer is ready to measure.

• Green, blinking—the spectrophotometer is measuring.

• Yellow—the spectrophotometer is in not-ready state, for example, turning 
one of the lamps on or if both lamps are switched off.

• Red—error condition, that is, the spectrophotometer does not pass one of 
the self-tests which are run when the spectrophotometer is turned on or an 
error occurred during operation. In this case the UV-visible operating 
software gives a detailed error message and possible explanations are in 
the online help system and in your Service Manual Chapter 3 “Diagnostics 
and Troubleshooting”.

• Red, blinking—error condition of the spectrophotometer processor system. 
Because in this case there is no communication with the computer there 
will be no error message. The online help system and your Service Manual 
Chapter 3 “Diagnostics and Troubleshooting” give more information about 
troubleshooting.

The four measure push buttons on the front panel cause the following actions 
to be performed and the resulting data being sent to the computer. The push 
button functionality is controller by the UV-visible ChemStation software and 
adjusted to the current measurement task.

• BLANK—the spectrophotometer takes a blank measurement. This comprises 
a reference measurement that is used in all subsequent sample 
measurements until a new blank measurement is taken. Following the 
reference measurement an additional baseline spectrum is measured and 
displayed on the PC.

• SAMPLE—the spectrophotometer takes a sample measurement or starts a 
series of measurements. This depends on the parameters set in your 
software.

• STANDARD—the spectrophotometer takes a measurement of a standard. 
Additional information such as concentration and so on, have to be entered 
in the operating software.

• STOP—the spectrophotometer and/or software aborts any ongoing activity 
and returns to a to ready state.
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Rear View

All connections are made at the rear of the spectrophotometer, see Figure 3.

• The multicell connector allows you to connect a multicell transport.

• The GPIO (general-purpose input/output) connector allow you to control a 
sipper and autosampler or other accessories depending on the software you 
are using.

• The remote connector is currently not used by Agilent instrument control 
software. It can be used e.g. to synchronize instruments.

• The RS232C connector may be used to control the spectrophotometer from 
a computer through RS232 connection, using appropriate software. The 
Multiple Instrument Firmware Tool provided can be used with RS232 
communication. The UV-visible ChemStation software currently supports 
LAN and GPIB communication only. 

Figure 3 Rear View of Spectrophotometer
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• The GPIB connector is used to connect the spectrophotometer with a 
computer. The 8-bit configuration switch module next to the GPIB 
connector determines the GPIB address of your spectrophotometer. The 
switches are preset to a default address recognized by the operating 
software from Agilent.

Only a single controller must be connected to the spectrophotometer at a 
time.

• The MIO board slot is reserved for a LAN interface board.

• The accessory board slot is reserved for future use.

• The power input socket does not have a voltage selector because the power 
supply has wide-ranging capability, for more information see your Service 
Manual Chapter 1 “Specifications”. There are no externally accessible 
fuses, because automatic electronic fuses are implemented in the power 
supply. The security lever at the power input socket prevents that the 
spectrophotometer cover is taken off when line power is still connected.

Side of the Spectrophotometer

On the right side of the spectrophotometer is a double door for access to the 
lamps. For exchanging lamps both doors, the plastic door and the sheet-metal 
door must be opened. Safety light switches are automatically turning off the 
lamps when the inner sheet metal door is opened.
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General Purpose Agilent ChemStation Software for UV-visible 
Spectroscopy — Overview

This section gives an overview of the elements of the user interface 
implemented with your Agilent ChemStation software and the data analysis 
concept behind. It explains how data are processed and what the advantages 
of this processing are on a practical point of view.
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User Interface Elements

Your general purpose Agilent ChemStation software for UV-visible 
spectroscopy facilitates operation of your diode-array-based UV-visible 
spectrophotometer in daily routine operation. The focus of this software is on 
ease-of-use and ease-of-learning. A graphical user interface visualizes the 
spectrophotometer operation and usage. This user interface consists of a 
number of elements as described in the following sections.

Menu bar

Tool bar

Analysis panel

Instrument panel

Method name

Mode switch

Tabular results

Spectra
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Menu

The more traditional menu interface at the top of the Agilent ChemStation 
window allows to control all operations.When you choose an item from the 
menu bar a list of commands and submenus is displayed. An operation is 
performed by choosing a command (mouse click or ENTER key).

Toolbar

The tool bar below the menu bar shows buttons with symbols, icons, which 
allow direct access to basic operations such as printing result reports, loading 
methods, and saving methods and data.

Side Panels

The panels on the left side are the analysis panel and instrument panel. The 
size and position of these panels are fixed but are a function of your display’s 
resolution. The minimum resolution is 600 × 800 pixels.

Analysis Panel

The analysis panel gives you a graphical visualization of the current context in 
which you are working. In addition it provides access to the setup dialog of 
your actual task by means of the Setup button.
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Instrument Panel

The instrument panel is below the analysis panel. It visualizes and controls 
your sampling devices and spectrophotometer. Part of the graphical elements 
on this panel are active items, for example, to switch lamps on or off, or run a 
peristaltic pump.

You can recognize the active areas by a pointer change when you move the 
mouse across the area. A mouse click in such an active position brings up a 
small menu with selections, or simply performs an operation.

In addition you can select a sampling system from the list of available systems. 
Its parameters can be adjusted by means of the Setup button.
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View

The area on the right side of the side panels offers you a view on a certain 
aspect of your current task. A view consists of one or more separate windows. 
These windows provide information in mainly a graphical or a tabular 
representation. You may see a graph showing your measured sample spectra 
and a table with the calculated results.

Views are usually handled automatically by the operation you performed, but 
you may also use the view menu’s commands to select the view you are 
interested in.
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Software Structure

To reduce complexity of operation the software is divided into specific 
applications, called modes. In addition levels of operation are available and 
support for data evaluation sessions without spectrophotometer control.

Agilent ChemStation Sessions

Your Agilent ChemStation belongs to the Agilent’s ChemStation family of 
instrument control software. An installation of Agilent ChemStation software 
can control up to four different UV-vis instruments based on a single PC. Each 
of these instruments has its own session

If you start a session, its name is indicated in the main application’s window 
title bar, for example, Agilent 845x UV-visible System[1].

Each instrument session is available for data analysis only and for instrument 
control. An instrument control session has the appendix (Online) and can be 
started as the first instance only on your PC. In addition a data analysis 
sessions, which has the appendix (Offline), can be launched. The offline 
session allow recalculations based on stored data and is useful in the 
development process of an analytical method.
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Operation Levels
The operation levels manager level and operator level apply to all modes and 
allow managing an application and running an application only. In the 
managing level of an application usually a method is developed and stored 
permanently to disk. The manager level of operation is password protected. 
This assures the integrity of predefined methods and operation sequences.

In the operator level only a reduced set of functions is available. Especially 
functions which may affect the integrity of an analytical procedure are not 
available. But on the other hand, an operator may use their own settings. This 
gets flagged on the tool bar and is be indicated on printed reports.

Agilent ChemStation Modes

The Agilent ChemStation modes are application oriented. Each mode has its 
own mode-specific menu, panels, operations and set of views. Your general 
purpose software for UV-visible spectroscopy is the platform for all modes. It 
is split into a Standard mode, an Execute Advanced Method mode and a 
Verification and Diagnostics mode.

According to your needs, modes are available for Advanced operation, 
Dissolution Testing runs, Multibath Dissolution Testing runs, Combined 
Reports evaluation, Kinetics measurements, Thermal Denaturation studies 
and Color Calculations.

These modes of operation can be switched within a running 
Agilent ChemStation session. All current raw data will be preserved during 
such a switch. This allows to look at your data with the focus on different 
aspects.

Most of the modes offer you the ability to define your analytical task by a set of 
parameters and, if necessary, data. A set of parameters and data can be saved 
to disk as a method. This allows you to repeat your analysis task under defined 
conditions simply by loading a method and running your samples.
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Standard Mode Tasks

The Agilent ChemStation modes also offer the ability to focus on a certain 
aspect, many parameters have to be managed to customize a mode for a 
certain application. To overcome this complexity your standard mode offers 
an additional focus on tasks.

The standard mode of your general purpose software for UV-visible 
spectroscopy is oriented towards the most common tasks performed in a 
analytical laboratory that employs UV-visible spectroscopy. Four tasks are 
available:

• Fixed Wavelength

• Spectrum/Peaks

• Ratio/Equation

• Quantification

A task is selected and activated from the analysis panel’s selection box.

This task orientation lets you quickly adjust the software to give you the right 
view and answers based on your data. These tasks have been derived from a 
survey of the most common UV-visible spectroscopic tasks done on a routine 
basis in analytical laboratories. Historically these tasks have been developed 
on filter photometers or scanning spectrophotometers. 

With your spectrophotometer you have the advantage that by default the 
entire UV-visible spectrum of your samples is available. So these four tasks do 
offer only different views to your data acquired.

A task switch within the Standard mode is much faster than an entire mode 
switch. An additional benefit of these tasks is that the definition of a method 
is done within a single dialog.
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Fixed Wavelength

The Fixed Wavelength task is used to look at measured sample data at up to 
six different wavelength. This data is available as absorbance, transmittance 
and first to fourth derivative.

Due to the spectral acquisition additional techniques such as internal 
reference or three-point, drop-line background corrections can be applied.

Spectrum/Peaks

In the Spectrum/Peaks task you are looking at absorbance minima and 
maxima. The focus here is more on the wavelength scale but you get the 
according absorbance readings in addition.
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Ratio/Equation

The Ratio/Equation task is used to perform a user-definable equation based on 
measured data and sample information. An equation can be setup using 
sample data at up to six wavelengths, and weight and volume data entered 
with the samples measured. By means of an equation, for example, analysis 
results based on chemical test kits can be automatically calculated and 
reported. Another application is to use a ratio of data values to check for the 
identity or the purity of a sample.

Quantification

The Quantification task allows you to do single component analysis based on 
four different types of calibration curves and a set of standards. Due to the 
spectral acquisition in addition background corrections can be applied to your 
data.

The calibration can be optimized for your concentration range of interest by 
changing the wavelength used for calibration. A new calibration and a new 
analysis is automatically performed based upon your current standard data.
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Standard Mode Data Processing

General Data Processing

Although knowledge of the internal design of the data flow and processing in 
not required to use Agilent ChemStation software, it helps to understanding 
how Agilent ChemStation processes your data and how this processing is 
controlled by your method’s parameters.

The data processing can be easily described using a model of data containers 
and operations visualized in a flow diagram.

All basic data go into a raw data container. This container is empty when you 
start your Agilent ChemStation session and it will be filled by measuring data 
or loading data from a file.

The raw data container held the originally acquired data as specified with 
your acquisition parameters and stamped with, for example, acquisition date 
and time as well as the acquisition operator’s name.

Raw Data

Processed
Spectra

Used
Wavelength

Results

Spectral Processing

Data Access

Data Evaluation
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Spectral
Processing

Your method defines how this data is analyzed. The first processing step is 
spectral processing. The processed raw data spectra are transferred 
automatically into a second container for processed spectra. This concept 
allows you to have a look at the results of this processing step by viewing 
the processed spectra container’s content. If you, for example, specified 
first derivative data type, the first derivative spectra of all your raw data 
are available in the processed spectra container after analysis. The type of 
spectral operation is defined by your method settings.

Used Wavelength

A next step in the data analysis process is the access to data for further 
evaluation specified in terms of wavelength and background correction 
operations such as an internal reference calculation or three-point, 
drop-line calculation.

This data is stored in the used wavelength container. In the Fixed 
Wavelength task, for example, a tabular view on these data is available with 
the Sample/Results Table window.

Results An additional step is the evaluation of the accessed data.
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In the Ratio/Equation task, for example, this used wavelength data is 
processed by an evaluation of the equation specified. This additional 
operation generates the calculation results. These calculated result values 
are filled into the results container.

The results are available with the Sample/Results Table.

Summary The generalized basic data processing is divided into three steps.

1 spectral processing

2 data access

3 data evaluation

These steps are always performed in the above order identically for all 
spectra in the raw data container. The results are placed in the results 
container. The previous content of the processed spectra, used wavelength 
and results container is replaced.
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Processing with Standards

In the forth task, in addition to your sample data, standards are used. This 
requires an extension to the above concept to handle standards. Two 
independent sets of containers, one for standards and another for samples 
have been implemented. All processing containers are doubled as well. As with 
the sample processing only, all evaluation steps are done in parallel on both 
the samples and the standards.

The evaluation in quantification is now a calibration using standards. The 
coefficients are calculated based on the method’s settings and the current 
standards in the Agilent ChemStation memory. This means results now 
become a function of a measured set of standards and the standard 
concentrations specified.

Raw Data
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Spectra
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Results

Spectral Processing
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Raw Data
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Calibration
Results
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These coefficients are then used to calculate concentration results for the 
samples currently in memory. The same processing steps applied to sample 
and standard data lead to the most precise results.

Advantages

The concept of a diode-array-based spectrophotometer in combination with 
powerful data evaluation based on Agilent ChemStation offers many 
advantages over traditional spectrophotometer systems. Some of these 
advantages from a practical point of view are briefly descibed below.

• Virtually Unlimited Number Of Standards

Due to this data analysis concept you can measure your standards before or 
after your samples and, besides the minimum required number of 
standards, you can use as many standards you like to use with your 
calibration.

• Easy Optimization

The availability of all raw data—samples and standards—means you can 
easily optimize your method’s settings by choosing a different calibration 
wavelength and re calibrating your system. And, the elimination of outliers 
in your calibration is possible by simply removing this standard from you 
standard data set.
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• Calibrated Method

When you save your method the standards currently in memory are always 
saved with the method. After loading a method, you can directly analyze 
your samples.

• Optimization for a Particular Sample

In addition you may optimize your wavelength settings for a sample outside 
the linear range of your actual calibration. Due to the excellent wavelength 
reproducibility of your spectrophotometer, you can switch to a wavelength 
with a lower extinction coefficient for precise analysis of such a sample.

• Summary

The availability of spectral raw data offers you many additional 
opportunities to optimize your calibration and analysis for best results. 
This optimization can be done quickly just by setting new method 
parameters. You get new answers almost instantaneously. The data analysis 
concept applied assures consistent and reliable results.
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This chapter does not replace the information available with the Installing 
Your UV-visible Spectroscopy System manual. It is meant as a reminder of the 
key steps of the installation and the system startup.
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Installation Summary for Your Agilent 8453 General Purpose 
UV-visible System

General

A detailed description of your Agilent 8453 general purpose UV-visible system 
is given with the manual Installing Your UV-visible Spectroscopy System. The 
summary reminds you of the key points of installation.

Spectrophotometer

✔ Make sure that your spectrophotometer has the LAN interface card 
installed.

✔ Check that your spectrophotometer is either connected to your PC directly 
using a crossover LAN cable or to your LAN using a direct connection.

✔ Check that your spectrophotometer is connected to a power outlet.

✔ Before you switch on your spectrophotometer, make sure that the Agilent 
Bootp Service is installed on your PC or your network administrator has 
assigned an IP address to your spectrophotometer. For details see the 
chapter “LAN Communication, Installation, Connection and Configuration” 
in your Installing Your UV-visible Spectroscopy System manual.

CAUTION Do not connect the LAN adapter of your PC to the CAN interface of the Agilent 8453 
spectrophotometer, otherwise the LAN adapter of the PC will be seriously damaged, 
because the operating voltage of the CAN interface (12 V) is higher than the 
operating voltage of the LAN adapter (5 V).

WARNING Always operate your instrument from a power outlet which has a ground 
connection. Always use the power cord designed for your region.
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PC

✔ Make sure that all of your PC components are connected to line power.

✔ Make sure that your general purpose software for UV-visible spectroscopy is 
installed.

✔ A printer must be configured on your PC.

• Adjust paper size (for example, Letter, A4)

• Set Orientation to Portrait

✔ The TCP/IP protocol must be installed and configured on your PC.

✔ Your spectrophotometer must be configured with its IP address.

✔ If you connected your spectrophotometer directly to your PC be sure that 
the Agilent Bootp Service is installed and configured. If you connect to your 
spectrophotometer using a LAN make sure that your network administrator 
assigns the IP address to your spectrophotometer.
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Starting a Measurement Session

With a network connection to your spectrophotometer it is important that 
your spectrophotometer is recognized by the software. This requires the 
assignment of a unique IP address at power on time to your 
spectrophotometer. The assignment is either done by the Agilent BootP 
Service application running on your PC with a direct connection to the 
spectrophotometer or in a LAN by a server application on your LAN. 
Therefore it is important that either one of these applications is up and 
running before you switch your spectrophotometer on.

✔ Switch on your PC and boot your PC operating system. If a printer is 
connected to your system, switch the printer on.

✔ Make sure that the Agilent BootP Service is running or you are logged onto 
your LAN.

✔ Switch your spectrophotometer on and wait until the spectrophotometer’s 
indicator light turns to green. This process includes the 
spectrophotometer’s self test and takes about one minute. For details on 
the startup sequence see chapter “Installation and Start Up” in your 
Installing Your UV-visible Spectroscopy System manual.

✔ Launch your measurement session by pressing your operating system’s 
Start button and select Programs, UV-Visible ChemStations, Instrument 1 
online.

✔ You are ready to use your system, if the blue busy status display on the 
system’s bottom message line turns off.

✔ The first measurement you have to perform is a reference measurement. 
After this alignment your are ready to measure absorbance data and 
spectra.

NOTE It takes about 15 minutes for the lamps to reach stable state conditions. For best results, do 
not perform measurements before this period of time has elapsed.
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This chapter describes

• making measurements

• selecting material, optical specification and type of cell

• handling and maintaining cells

• checklist for good results

• solvents selection

• sample preparation

• use of filters

• stirring and temperature control of sample

• how to insert cells into the cell holder.
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General Considerations

There are many factors that can affect the results of your measurements. This 
section provides brief discussions of some of the more important ones.

Spectrophotometer Design

The sample compartment of the Agilent 8453 spectrophotometer is open. 
Unlike conventional instruments the Agilent 8453 does not suffer from 
ambient false light. The open sample area makes it easier to access it generally 
and to connect tubing to a flow cell or thermostattable cell holder.

Making Measurements

Blank (Reference) and Sample Measurement

Your spectrophotometer is a single beam instrument so you must measure a 
blank before you measure a sample. For the high accuracy measurements, the 
blank and the sample measurement should closely follow each other.

In general, a blank measurement should be repeated as often as is practical. 
Even in a thermally stable environment, a blank measurement should be taken 
at least every half hour to ensure accurate results.

Chemically, the only difference between the blank and the sample should be 
the presence of the analyte(s). For measurements with liquid samples, the 
blank should be a sample cell filled with the solvent you plan to use.
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Sample Cell Material

Quartz sample cells or sample cells with quartz face plates are required if you 
want to use the full 190 to 1100 nm wavelength range of your 
spectrophotometer.

If you plan on working only in the visible and/or short-wave near-infrared 
range of 350 to 1100 nm, you can use good quality glass cells.

Disposable plastic sample cells, for measurements in the range 400–1100 nm, 
are also available. The quality of these cells varies and they are generally not 
recommended.
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Optical Specifications of Cells

The accuracy of the readings of a diode-array spectrophotometer is very 
sensitive to spatial shifts of the measurement light beam. Cells having non 
parallel opposite faces, or so called wedge shaped cells, lead to a spatial shift 
of the light beam (see Figure 4). Therefore, the opposite cell walls illuminated 
by the analysis light beam have to very parallel. The parallelism is measured in 
terms of the angle between the two opposite cell walls. We recommend to use 
10 mm path length cells with an angle which is below 0.1 degrees of an arc.

Figure 4 Shift of the Spectrophotometer Light Beam due to non Parallel Cell Walls
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Apertured Cells

In applications where sample volume is limited, apertured or microcells are 
used. The width of these cells is reduced to reduce the volume and the blank 
part of the cell must be blackened to avoid unwanted transmission and 
reflection through the side walls. If the side walls are not blackened the result 
will be poor photometric accuracy and, if different concentrations are 
measured, poor linearity.

The disadvantage of apertured and microcells is that part of the light beam is 
blocked. Not all the light passes through the sample and there can be some loss 
in sensitivity. See Figure 5 for recommended and Figure 6 for cells you should 
not use with the instrument.

Figure 5 Recommended Cells

Quartz cells Quartz cells with black apertures*

CAUTION * Quartz cells with black apertures smaller than 2 mm, when used with a multicell 
transport, can lead to measurements of poor reproducibility.
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Flow Cells

We recommend a sipper system with a flow cell for obtaining the high 
precision measurements. Using a flow cell eliminates the necessity of moving 
the cell between blank measurement and sample measurement. Also, the cell 
can be rinsed thoroughly with the solution to be measured.

The design of the flow cell should minimize entrapment of bubbles and flow 
channeling to provide the most reliable results.

Figure 6 Cells You Should Not Use With the Instrument

Quartz cells with transparent apertures, 
fluorescence cells, plastic cells
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Handling and Maintaining Cells

Passivating New Cells

When filling a non-passivated new cell with your sample, you will observe that 
air bubbles stick on the windows of your cell. To prevent the formation of 
sticky bubbles, rinse the cell with cleaning and passivating fluid (part number 
5062-8529). The cleaning procedure you should apply is described on the label 
of the cleaning fluid container.

Cleaning Cells

The fats in fingerprints are significant absorbers in the UV region and, if left 
on optical surfaces, can cause erroneous results. Wipe off all fingerprints and 
contaminants before using a sample cell.

Use only high quality lens tissues (part number 9300-0761) and never dry the 
inside of a cell with lens tissues. Dry the inside of the cell with pressurized, oil 
free air, that prevents the cell from getting contaminated with tissue particles, 
or rinse the cell with blank or sample solution. Floating particles in the cell 
will deflect the light beam and so lead to a very poor quality of the measured 
spectrum.

Figure 7 Floating Particles in a Cell

Floating particles will 
deflect and scatter the light 
beam
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Lens tissues for glasses or other uses often contain detergents or lubricants 
which can affect your measurements. If possible avoid cleaning the faces of 
your cell between blank and sample measurements.

Handling Cells

Always install a cell so that it faces the same direction to minimize problems 
with cell non-uniformity. For best results with microcells, leave your sample 
cell clamped in position throughout the measurement sequence. Solutions 
should be removed and replaced by pipette or use flow cells.

Figure 8 Spectrum Taken With Floating Particles in the Light Path

CAUTION If glass pasteur pipettes are used, make sure that the optical windows of the cell are 
not touched or scratched by the pipette.
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Solvents

Your choice of solvents should be based primarily on the solvent’s absorbance 
characteristics over the wavelengths of interest, its suitability as a solvent for 
the analyte, and on experimental conditions. Table 1 lists common solvents 
and the lower limit of their useful wavelength range.

Table 1 Lower Limit of UV Transmission for Some Common Solvents

Lower Limit Solvent

180–195 nm Sulfuric acid (96%)
Water
Acetonitrile

200–210 nm Cyclopentane
n-Hexane
Glycerol
2,2,4-Trimethylpentane
Methanol

210–220 nm n-Butyl alcohol
Isopropyl alcohol
Cyclohexane
Ethyl ether

245–260 nm Chloroform
Ethyl acetate
Methyl formate

265–275 nm Carbon tetrachloride
Dimethyl sulfoxide
Dimethyl formamide
Acetic acid

280–290 nm Benzene
Toluene
m-Xylene

Above 300 nm Pyridine
Acetone
Carbon disulfide
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When using volatile solvents such as acetone or methylene chloride, make sure 
that the sample cell is stoppered. Evaporation of a solvent does change the 
solute concentration and can cause solution noise due to solute convection 
currents. Both of these will affect the accuracy of your measurements. We also 
recommend stirring and temperature control when you use volatile solvents.

When using water as solvent we recommend using UV grade or HPLC grade 
water to reduce unwanted absorbance from impurities in the water. If you are 
using the sipper/sampler system the water should be degassed to avoid bubble 
formation in the flow cell, especially if the water comes from a pressurized 
water supply.

Sample Preparation

The sample cell should be rinsed three to five times with your intended solvent 
before you fill it with the pure solvent that will be used in the measurement. 
Turning the cell upside down on a small stack of absorbent tissues will help 
remove any residual solvent. This treatment will minimize contamination from 
previous experiments.

Samples which contain colloidal dispersions, dust or other particulate matter 
should be filtered, centrifuged or allowed to settle. If not, the overall 
attenuation-of-transmittance spectrum due to light scattering and/or 
reflection will hide the spectral information from the analyte.

WARNING Many of the solvents in Table 1 are hazardous. Be sure you fully understand their 
properties before using them.
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Photosensitive Samples

A few substances are very photosensitive. They degrade or undergo 
photochemical reactions if exposed to light. This can be easily seen by a 
decrease of sample absorbance over time.

Use of Filters

The shorter wavelength, higher-energy UV light is most likely to degrade 
photosensitive samples. If you have a problem, you can selectively block 
portions of the UV spectrum with a UV cut-off filter. An optical filter wheel 
assembly with three cut-off filters is available for the spectrophotometer. The 
cut-off wavelength of the filter you choose should be low enough that it does 
not eliminate important spectral information but high enough that it blocks 
the light that could degrade your sample. If you use a filter with your samples, 
you must use the same filter when you make your blank measurement.

Turning the D2-Lamp off

The short wavelength radiation leading to photodegradation comes from the 
light of the D2-lamp. For application where readings are taken at wavelengths 
above 400 nm, the D2-lamp can be turned off. The light intensity supplied by 
the Tungsten lamp is sufficient for a good signal to noise ratio over the 
wavelength range 400–1100 nm. When using cells with small apertures, you 
should check the signal to noise ratio by making sample measurements under 
conditions of your application.
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Stirring and Temperature Control

Solution homogeneity can be a problem, especially for viscous solutions. There 
are cases where, due to convection induced gradients, rapid absorbance 
changes may give irreproducible data. These changes can be observed 
spectroscopically by taking measurements with short integration times. To 
minimize convection effects keep the temperature of your sample the same as 
the cell holder or environmental temperature. Problems like these can also be 
minimized by using a thermostattable cell holder and/or a stirring module.

A similar effect can occur in cases of incomplete mixing. This is especially true 
where the specific gravities or miscibilities of the solvent and analyte are quite 
different. Again, stirring is a way to prevent this kind of problem.

In an unstirred cell, it is sometimes possible to observe local photodegradation 
of sensitive analytes. Because the actual volume of the sample in the light path 
is very small, stirring the sample will reduce the time any given analyte 
molecule is in the light path. This minimizes the photodegradation and 
increases homogeneity. Using a flow cell with continuous flow can yield 
similar results.

Checklist for Best Results

Cell:

✔ Cell is made of quartz or glass

✔ Apertured cells has black sides

✔ Apertured cells has an aperture greater than or equal to 3 mm 

✔ Cell windows are free of fingerprints and other contamination

✔ Flow cell used instead of an apertured standard cell

Measurements:

✔ Solution in cell is free of floating particles

✔ Solution in cell and cell walls are free of bubbles

✔ Solution in cell is mixed homogeneously

✔ Blank measured on same solvent as sample
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✔ Blank measurement shows a flat baseline (Figure 9 and Figure 10 on 
page 52 show a good and a poor baseline)

✔ Cell orientation of blank and sample measurements is the same

✔ Ideally the cell is not removed between the measurement, which means the 
cell is filled/rinsed using a pipette or a flow cell is used

✔ Time between blank and sample measurement should be short

Figure 9 Example of a Blank on Water Showing a Good Baseline
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Figure 10 Example of a Blank on Water with Bubbles Causing a Poor Baseline

NOTE If your blank or spectra shows artifacts similar to the one in Figure 10, see “Solvents" on 
page 47 to optimize the measurement procedure.
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Inserting a Cell

Your spectrophotometer is shipped with the standard single-cell holder you 
first have to install in the sample compartment. This cell holder 
accommodates standard cells or flow cells. To insert a sample cell in the cell 
holder:

1 Move the locking lever to its up position. 2 Insert the sample cell, making sure you orient it 
correctly. The frosted (non-clear) sides of the 
sample cell should not be in the path of the light 
beam.

3 Lock the sample cell in place by pushing the locking 
lever back down.

Utmost care should be taken when using small 
volume flow cells and particularly any cells with less 
than a 2 mm aperture. Here is is imortant that the 
cells are properly centered in the light path. The cell 
holder is designed for cells with 15 mm center 
height. If applicable these cells should not be 
removed between the respective reference (blank) 
measurement and the sample measurement.
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Starting Your First Measurement Session
Starting Your First Measurement Session

1 Make sure that your Agilent 8453 UV-visible system has been installed 
correctly.

For details of installation see your Installing Your UV-visible Spectroscopy 
System manual.

2 Switch on your PC, monitor and printer.

3 Log on to your PC operating system.

Check your Agilent BootP Service is running using the Control Panel’s 
Administrative Tools Services dialog or make sure that your network 
administrator has integrated your Agilent 8453 spectrophotometer into 
your local network.

4 Switch on your Agilent 8453 spectrophotometer.

A running BootP service will now assign the configured IP address to your 
spectrophotometer. In the standard installation the Agilent BootP Service 
performs this task.

5 Start your measurement session by selecting Instrument 1 online from the 
menu.

Your Instrument Panel shows you the current state of the 
spectrophotometer and the Blank button is enabled.
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6 The first task you have to perform is to measure a reference. Typically the 
cell containing the solvent used with your samples is put in the 
measurement position and a blank measurement performed. To start this 
measurement, click the Blank button on your Instrument Panel or press the 
spectrophotometer’s Blank button.

A blank measurement is a reference measurement combined with the 
measurement of a baseline spectrum. A baseline spectrum gives you 
additional hints on the absorbance of the cell windows and the solvent. 
Areas with high noise indirectly indicate high absorbance.

7 The next measurement is your sample measurement. To get the most 
precise results, use the same cell in the same orientation to the 
measurement beam. Flush your cell about three times with your sample 
solution and start the measurement by clicking the Instrument Panel’s 
Sample button or by pressing the spectrophotometer’s Sample button.

NOTE For high precision measurements, wait until the spectrophotometer and the lamps have 
reached thermal equilibrium. The time required is a function of the environmental 
conditions. Your spectrophotometer should be ready after 45 minutes.

NOTE For details on how to mount your cell, see “Inserting a Cell" on page 53.
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Starting Your UV-visible Software

This section describes how you start an Agilent ChemStation session on your 
PC. If you want to perform measurements, you can start an online session, or 
you can start an offline session for optimizing the analytical parameters of a 
method, recalculating results or printing reports.

An online session can be started only as the first instance on your PC. In 
addition an offline session can be started in parallel. This allows you to 
optimize your method settings by direct comparison based on identical sets of 
data.

1 Switch on your PC, monitor and printer.

2 Log on to your PC’s operating system

3 Start your Agilent ChemStation session by selecting Instrument 1 online, 
for a measurement session, or Instrument 1 offline, for method 
optimization and data evaluation.

4 Enter your name to log on to your Agilent ChemStation session. If you 
protected your manager level by password, you must enter the correct 
password. The system will then come up with the last-used mode and 
method.
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Measuring Caffeine Absorbance at 273 nm

This section describes how you measure your caffeine sample that was 
shipped with your spectrophotometer. Measurement of this caffeine sample is 
also used for the IQ (installation qualification) of your Agilent 8453 
spectrophotometer.

1 Make sure that you are in Standard mode. The mode is indicated on the 
toolbar of your Agilent ChemStation session.

2 Select the Fixed Wavelength task in the analysis panel’s selection box.

3 Click Setup in the analysis panel to open the parameter dialog.
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4 Type the wavelength of interest in the Wavelengths section of the Fixed 
Wavelength(s) Parameters dialog. Adjust your spectral display to a 
wavelength range from 190 nm to 400 nm in the Display spectrum section. 
Click OK to set your parameters.

5 Fill your 1 cm path length quartz cell with distilled water. Lift the lever at 
the left side of your cell holder. Put the cell in the cell holder and make sure 
the transparent windows face towards the font and the back of the 
spectrophotometer. Push the lever down to secure your cell in the cell 
holder.
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6 Press the Blank button on the front of the spectrophotometer or click Blank 
on the Instrument Panel to start the measurement.

7 Remember the orientation of the cell in the cell holder. Lift the level to 
release the cell, remove it and flush it three times with about 1 ml of your 
caffeine sample. Then fill the cell with about 3 ml of the caffeine sample. 
Make sure that the cell windows are clean and reposition the cell in the 
same orientation as for the reference measurement. Close the cell holder’s 
level.

8 Press the Sample button on the front of your spectrophotometer or click 
Sample on the Instrument Panel to start the measurement.

9 The view shows you the spectrum of your caffeine sample with a vertical 
line indicating your wavelength of interest. Below the spectrum is the 
Sample/Result Table which shows the absorbance reading at 273 nm.
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Saving Your Parameters as a Method

This section describes how to save your settings for a future 
Agilent ChemStation session. Simply by loading your method you adjust your 
Agilent ChemStation to repeat your measurement. A library of methods 
facilitates routine laboratory work.

Let’s assume that your current settings are defining your method to analyze a 
caffeine sample. To be able to repeat such an analysis all set parameters can be 
stored permanently to disk. This allows you to load such a method on your 
system or even transfer such a method to your colleague with a 
Agilent ChemStation system.

1 Choose Save Method As… from the File menu or click the icon.
62 Agilent 8453 UV-visible Spectroscopy System Operator’s Manual



Using your Agilent 8453 UV-visible Spectroscopy System 4
Saving Your Parameters as a Method
2 This displays the Save Method As… dialog box. Type the method name in 
the File name field, for example, Caffeine.m. Click OK to save your method.

NOTE If you generate many methods, you can use Options & Infos… from the Method menu to 
add text for documentation purposes and to simplify method access. This displays the 
Method Options & Information dialog box. In the Method Information section you can enter 
a sort descriptive text which becomes part of your method.
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Retrieving and Printing a Method

This section describes how to access methods and print a method report.

1 Choose Load Method… from the File menu or click the icon in the toolbar.

NOTE If your current method has been modified, a dialog box will ask you whether you want to 
save or ignore these changes.
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2 The Load Method… dialog is displayed. The selected method’s information 
is shown in the File Information section of the dialog box.

3 If you want to load this method, click OK.

NOTE Whenever you change a parameter of the current method, you get an indication in the 
toolbar’s modification field.

.

This triggers the reminder dialog mentioned above.
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4 To print a method, choose Print, Method from File menu.

NOTE To be able to print your method report, your printer must be properly configured and online. 
An alternative, if your printer is currently not online, is to view the print preview on the 
screen.
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Saving and Retrieving Data

This section explains how you can save and retrieve measured data. This data 
can be used for archiving, for method development at a later stage, or for 
exchange with other Agilent ChemStations.

Your Agilent ChemStation has the ability to store and retrieve your data using 
a binary, checksum protected data format (extension *.sd,*.std). All current 
spectra -samples or standards- can be saved to disk for permanent storage. 
Save and load of data is possible using local and network drives. In addition a 
single spectrum can be selected for storage.

Saving your Samples

1 Choose Save, Samples As… from the File menu or click the toolbar icon.
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2 You select one of your already existing data files in the File name selection 
box of the Save Spectra As… dialog or you type a valid file name into the 
File name edit box.

3 Click OK to start the operation.

NOTE A valid file name consist of eight alphanumeric characters and the file extension .sd or .std. 
Usually the extension .std is used for standards only.

If the file name exists already, a message box is displayed allowing you to abort or continue 
with the operation.
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Saving a Selected Spectrum

1 Select the spectrum of interest in the graphic window.

Or, in the tabular Sample/Results Table window.

2 Choose Save, Selected Spectra As… from the File menu.

NOTE You may get the warning, Select/activate a window!, on the message line, if you did not 
select either the Overlaid Sample Spectra window or the Sample/Results Table window.
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3 You select one of your already existing data files in the File name selector 
box of the Save Spectra As… dialog or you enter a valid file name into the 
File name edit box.

4 Press OK to start the operation.
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Retrieving Spectra

1 Choose Load, Samples… from the File menu.

2 You select the data file in File name selector box of the Load Spectra to 
SAMPLES dialog box.
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3 Click OK to start operation. The spectra available with your data file are 
added to the files currently in the Agilent ChemStation sample container.

Deleting Current Spectra

1 Choose Clear, Samples from the Edit menu or click the toolbar icon.

NOTE You can look at the File Information of your files by moving the selection in the file selector 
box. The content is always updated with the current selection.

NOTE Clear, Standards and Clear, Math. Results can be used to delete the current standards 
respectively the current mathematical results spectra from Agilent ChemStation memory.
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Print Preview of Reports

Print preview allows you to look at the report in a separate 
Agilent ChemStation window based on the currently configured printer. All 
types of available reports can be checked page by page in the preview window. 
The number of pages generated and the layout also can be checked. In addition 
the currently displayed report can be printed.

Print Preview of a Results Report

The print previews work similarly for all available types of reports. The 
example below shows you how to preview your results report.

1 Choose Print Preview, Results from the File menu.
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2 The report generated will be displayed in the preview window.

NOTE Printing a results report requires you to have set all parameters properly and have data 
available for evaluation. If you do not have data, you may get the message No results 
present! on the message line.
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This window allows you to look at your report page by page. Scroll bars are 
available if a page does not fit into the actual preview window.

In addition, you may use a different size for your preview display. Three sizes 
are available with the size selection box. Depending on your display resolution 
select the one which best fits your needs.

The following functions are available with the print preview window:

• The Prev and Next buttons allow you to browse through the report pages.

• A selection box allows to jump to a page directly.

• The Print button sends the report to the printer which is displayed in the 
lower left corner of the print preview window.

• The Close button closes your print preview window and discards the report 
shown.
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Finding the Caffeine Absorbance Maximum

This section describes how you find the absorbance maximum for your 
caffeine IQ sample.

1 Make sure that you are in the Standard mode. The mode is indicated on the 
tool bar of your Agilent ChemStation session.

2 Select the Spectrum/Peaks task in the analysis panel’s selection box.

3 Use the Setup button of the analysis panel to open the parameter dialog.
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4 Type 2 for the number of peaks to find and uncheck the valley find option. 
Set your data type to absorbance and adjust your spectral display to a 
wavelength range from 190 nm to 400 nm in the dialog’s Display spectrum 
section. Click OK to set your parameters.

5 Fill your 1-cm path-length quartz cell with distilled water. Lift the lever at 
the left side of your cell holder. Put the cell in the cell holder and make sure 
the transparent windows face towards the font and the back of the 
spectrophotometer. Push the lever down to secure your cell in the cell 
holder.
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6 Press the Blank button on the front of the spectrophotometer or click Blank 
on the Instrument Panel to start the measurement.

7 Remember the orientation of the cell in the cell holder. Lift the level to 
release the cell, remove it and flush it three times with about 1 ml of your 
caffeine sample. Then fill the cell with about 3 ml of the caffeine sample. 
Make sure that the cell windows are clean and reposition the cell in the 
same orientation as for the reference measurement. Close the cell holder’s 
level.

8 Press the Sample button on the front of your spectrophotometer or click 
Sample on the Instrument Panel to start the measurement.
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9 The view shows you the spectrum of your caffeine sample. Two peaks were 
found marked and these annotated with the wavelength. Below the 
spectrum graph the Sample/Result Table shows the wavelength of the peaks 
found and the measured absorbance values.
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Entering your Cell’s Path Length

The cells used for your measurements are specified with the sampling system 
parameters. In quantitative calculations these parameters are used in results 
calculation. Due to the freedom of choices for the cell path length, you must 
provide the correct value with the path length setting. Usually you get this 
information from the supplier of your cells. You so set the path length in 
manual mode cell handling as follows.

1 Click Setup on the Instrument Panel.

2 Type the path length in cm in the Setup Manual dialog box.

3 Click OK to set the specified path length.
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Controlling your Sipper System

A sipper system transfers your sample by means of a peristaltic pump into a 
flow cell for the measurement. To control your sipper system through the 
Agilent ChemStation software, you have to adjust your current sampling 
system for sipper introduction.

In addition, due to the length of tubing, the dead volume of your flow cell and 
the flow rate of your pump, you adjust your sipper system parameters. For 
details see your Installing and Operating Your Sipper System manual.

1 Select the Sipper in the Instrument Panel selection box.

2 Click Setup on the Instrument Panel. Type the path length of your flow cell 
in cm and click OK.

3 Click Setup again and access the Sipper Parameter dialog by clicking 
Parameter. The parameters required can be determined using the Flow Test 
task of your Verification and Diagnostics mode.
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4 Click OK in the Sipper Parameter dialog and click OK in the Sipper dialog to 
set the parameters.

NOTE Every measurement you start by clicking one of the Instrument Panel measurement buttons 
or by pressing the spectrophotometer buttons uses the sipper for sample introduction. 
Sipper introduction is also used by an automated sequence.
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Using your Multicell Transport

The multicell transport is a cell changer which allows you to position up to 8 
cells in the measurement position automatically. You may use different cells in 
each measurement position. The path length can be specified individually for 
each of the cell positions.

1 Select Multicell (8-cell) in the Instrument Panel selection box.

2 Click Setup on the Instrument Panel. Type the path lengths of all cells used 
in cm and click OK.

NOTE For details about your multicell transport see your Installing and Operating Your Multicell 
Transport manual.
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3 To move your cell for the next measurement into the measurement position, 
click the cell on the Instrument Panel or choose Multicell Transport 
Position from the Spectrophotometer menu to access Multicell transport 
Control dialog. In the Multicell Transport Control you press one of the 
position buttons to move the multicell transport.
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NOTE In an automated sequence the multicell transport can be used for automatic sample 
introduction. A maximum of 8 samples can be introduced. If you specify more than 8 
measurements you get the warning:

You may also control an existing 7 position multicell transport. The major differences are 
that you have no separate reference position and one cell position less.
Agilent 8453 UV-visible Spectroscopy System Operator’s Manual 85



4 Using your Agilent 8453 UV-visible Spectroscopy System
Quantitative Analysis using a Calibration with Standards
Quantitative Analysis using a Calibration with Standards

Your quantitative analysis task is based on a calibration with standards. After 
a successful calibration the measured standards can become part of your 
method. Such a method can be used directly for quantitative analysis of 
samples.

After having setup your method calibrated samples can be analyzed. Several 
views of both your standards and the calibration as well as on your samples 
and results are available.

As a quick introduction a calibration using Beer’s law with a single standard 
and the analysis of a sample are described. Further, the only limitation on the 
number of samples and standards is the memory capacity of your 
Agilent ChemStation.

For the practical experiment we use the IQ caffeine sample as standard and a 
1:1 dilution with distilled water as sample. For the calibration we use 
absorbance data at 273 nm.
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Setup

1 Make sure that you are in the Standard mode. The mode is indicated on the 
tool bar of your Agilent ChemStation session.

2 Select the ‘Quantification’ task in the analysis panel’s selection box.

3 A new task panel is displayed and the Quantification Parameters dialog is 
opened automatically.

NOTE If you are already in the Quantification task, use the Setup on the analysis panel to open the 
parameter dialog.
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4 Setup your analysis wavelength at 273 nm (Use wavelength), type Caffeine 
for the Analyte name, set the Calibration curve type to Linear, select 
Concentration entry and use mg/l as Unit. Check the Prompt for standard 
information and the Prompt for sample information. Select Absorbance as 
Data type and set Display spectrum From 190 nm To 340 nm.

5 Click OK to set your parameters.

NOTE Now you are ready to run your measurements.
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Calibration

1 Fill your 1-cm path-length quartz cell with distilled water. Lift the lever at 
the left side of your cell holder. Put the cell in the cell holder and make sure 
the transparent windows face towards the front and the back of the 
spectrophotometer. Push the lever down to secure your cell in the cell 
holder.

2 Press the Blank button on the front of the spectrophotometer or click Blank 
on the Instrument Panel to start the measurement.

3 Remember the orientation of the cell in the cell holder. Lift the level to 
release the cell, remove it and flush it three times with about 1 ml of your 
caffeine sample. Then fill the cell with about 3 ml of the caffeine sample. 
Make sure that the cell windows are clean and reposition the cell in the 
same orientation as for the reference measurement. Close the cell holder’s 
level.

4 Press the Standard button on the front of your spectrophotometer or click 
Standard on the Instrument Panel to start the measurement.
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5 Enter your standard’s information in the Standard Information dialog box 
and click OK.

6 Your Agilent ChemStation software automatically calibrates and displays 
the calibration results. After a successful calibration the task panel’s 
calibration curve shows green. This indicates that your method is ready for 
analysis.

NOTE The Task panel’s Samples and Standards buttons can be used to switch your current view 
to the samples or standards view.

At this point you can also save your method for future use. See “Saving Your Parameters as 
a Method" on page 62 for more information.
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Analysis

1 Remember the orientation of the cell in the cell holder. Lift the level to 
release the cell, remove it and flush it three times with about 1 ml of your 
caffeine sample (1:1 dilution with distilled water). Then fill the cell with 
about 3 ml of the caffeine sample. Make sure that the cell windows are clean 
and reposition the cell in the same orientation as for the standard 
measurement. Close the cell holder’s level.

2 Press the Sample button on the front of your spectrophotometer or click 
Sample on the Instrument Panel to start the measurement.

3 Enter your sample’s information in the Sample Information dialog box and 
click OK. The view switches to the samples and your quantitative results 
will be displayed with the Sample/Result table.
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NOTE To save your data for future use or for documentation purposes, see “Saving and Retrieving 
Data" on page 67 for more information.
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How Can I Be Sure That My Agilent 8453 Works Properly?

The quality of your measurement data is dependent on the performance of 
your spectrophotometer. For a full performance verification external 
standards are required. Standard kits are available for operational 
qualification and performance verification (OQ/PV). OQ/PV kits for the 8453 
are available as part numbers 5063-6503 and 5063-6521.

A quick check without the need of standards can be performed by the 
Verification and Diagnostics mode’s self test. This test can be performed 
always after starting the spectrophotometer.

Agilent 8453 Self test

1 Make sure that you are in the Verification and Diagnostics mode. The mode 
is indicated on the tool bar of your Agilent ChemStation session.

2 Select the Self-Test task in the analysis panel’s selection box.
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3 Choose Self-Test, Start from the Task menu or click Start to start the 
self-test.

NOTE The spectrophotometer should be in stable working conditions before you initiate the test. 
If these conditions are not met, you may get a warning message.
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4 The self-test results are displayed with pass/fail criteria.

NOTE Self-test results can be stored with the spectrophotometer. Storing the self-test results 
with the spectrophotometer allows you to monitor the performance over time. Graphical 
representations of the self-test histories can be generated.
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How Can I Get a Deeper Understanding of UV-visible 
Spectroscopy?

The basic principles of UV-visible spectroscopy are available with your help 
system. The information contained in the Tutorial’s Basics of UV-Visible 
Spectroscopy covers Basic Principles through to details of Derivative 
Spectroscopy.

In addition, solutions to selected topics in UV-visible analysis are described. 
There you can find help on topics such as Enhancing Sensitivity or 
Determining Purity.
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More specific examples, including data, are available in the Examples section 
of the Standard Mode help. These can be used to run your 
Agilent ChemStation software for the special purpose described.
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When Do I Have to Measure a Blank?

The measurement data acquired by your spectrophotometer is instrument 
independent. To achieve this independency, a reference measurement must be 
performed. All consecutive measurements are referring to the last measured 
reference.

In the Agilent ChemStation software, the reference measurement is combined 
with a baseline measurement. The baseline displayed is information about the 
quality of the current reference. In absorbance mode the data should be close 
to 0 AU and in transmission mode the data should be close to 100%.

Typically reference measurements for dissolved samples are made on the cell 
filled with the solvent used. Here, in addition, the absorbance properties of the 
cell and the solvent are influencing the reference data. In wavelength ranges 
where your solvent or cell is absorbing, the noise of the baseline spectrum is 
high. Reliable sample data cannot be expected in these areas.

Therefore new reference or blank measurements are required when

• you change your measurement cell or its orientation relative to the 
measurement position

• you use a different solvent or event a different lot of the same solvent

• the time between your reference measurement and the sample 
measurement get too long

• the time conditions are depending on the aging rate of your lamps and 
possible changes of your environmental conditions—typically the last blank 
measurement should not be older than half an hour.
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